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Foreword 

 

Agile+ Relief C/C++(hereafter referred to as Agile+ Relief) CERT options are applied to 
analyze and output messages on source programs written in the C language/C++ 
language and header files for CERT C Coding Standard(hereafter referred to as CERT) 
violations. 

 

This manual illustrates usage of Agile+ Relief CERT option. 

For more information regarding message information output for program defects in Agile+ 
Relief, please also refer to "Message Indications Manual".  

For more information regarding error message output in Agile+ Relief, please refer to 
"Command Manual". 

 

References: 

[SEI CERT C Coding Standard]- Carnegie Mellon University, Software  
Engineering Institute 
(https://wiki.sei.cmu.edu/confluence/display/seccode/SEI+CERT+Coding+Standards) 

 

This manual was written based on the information of July 8, 2019. 

This information might change without a previous notice. 

 

 

 

 

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United 
States and certain other countries. 

MISRA and its logo are registered trademarks of MIRA Ltd, held on behalf of the MISRA 
Consortium. 

CERT is registered trademark of Carnegie Mellon University in the United States. 

All other product and service names mentioned in this document generally imply 
trademarks of their respective owners.  

This written material contains specific technology that falls under the [Foreign Exchange 
and International Trade Law]. Therefore, the export of any part of this documentation 
without consent is illegal. 

                                                        FUJITSU Limited 

Note 

⚫ No part of this publication may be transcribed and printed without prior written 
permission.  

⚫ Information contained within this manual is subject to change without notice.  

     

 

All rights reserved, Copyright(C) 2005-2023 FUJITSU LIMITED. 
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1 Before using the Agile+ Relief CERT option 

 

This chapter explains the synopsis of the CERT option. 

 

1.1 What is the CERT option 

 

The CERT option analyzes the source program and the include file written by C 
language/C++ language, and offers the function that inspects the violation of CERT.  

When the license of the CERT option is owned, the CERT inspection associates the  that 
Agile+ Relief detects with the CERT guideline. 

 

1.2 Shipped-conditions of CERT option 

 

The following Agile+ Relief products are necessary to use the CERT option. 

Agile+ Relief C/C++ V1.1.1 

- The license of the CERT option is necessary. 

 

1.3 License management 

 

The license of the Agile+ Relief C/C++ and the CERT option is necessary for the CERT 
inspection.  

When two or more CERT inspections are executed in the simultaneous or the violation of 
CERT is confirmed with viewer, the license is used. When the license is insufficient, two or 
more licenses are necessary. 

 

1.4 Limitation 

 

1.4.1 pg5 Command 

 

The presentation content of the pgr5 commands is different according to the presence of 
the CERT option.  

Please execute the pgr5 commands after making the license of the CERT option a valid. 

Please refer to "Message Indications Manual" for details of the indicated message that the 
pgr5 command points out. 

 

1.4.2 Cooperation with Agile+ Relief 

 

The CERT option does not support Agile+ Relief body. 
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1.4.3 Linkage Tools (Diagnosis report, CI tool Collaboration Jenkins Plugin) 

 

It does not correspond to the following data linkage tools. 

 Diagnosis report 

 CI tool Collaboration Jenkins Plugin 

 

2 Let's use CERT option 

 

This chapter explains how to use the CERT option. 

Please refer to the picture below for details of the usage. 

 

how to use the CERT option 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Setting of version of  
CERT guideline ID 

(2) Setting of CERT guide line ID   
of inspection target 

2.1 Setting of  
CERT C descriptor 

2.2 Setting of  
CERT guide line ID  
of inspection target 

(3) Analysis of source code 

 

(4) Confirmation of CERT 
inspection results 

(3) Analysis of source code  
by pgr5 command 

(4) Analysis of pgr5 command 
output result by pgrcert command 

(5) Confirmation of CERT 
inspection results 

2.3 GUI for CERT inspection 2.4 CERT inspection with  
Command Line 
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2.1 Setting of CERT C definition files 

 

CERT C Definition Files are configuration file group in which Agile+ Relief defined the 
CERT guideline ID of a possible sensing. 

CERT C Definition Files are stored as follows. 

 

⚫ Directory that stores CERT C Definition Files 

 

Windows version: 

"(Agile+ Relief C/C++ installation directory)\Analyze\EPOM\CertInfo\(Directory that 
stores CERT C Definition Files)" 

 

Linux version: 

(Agile+ Relief C/C++ installation directory)/Analyze/EPOM/CertInfo/(Directory that 
stores CERT C Definition Files) " 

 

When Agile+ Relief is installed, CERT C Definition Files are stored in these directoriess. 

 

⚫ Naming convention of directory name where CERT C Definition Files are stored 

 

C_YYYYMMDD_pgrVersion 

 

YYYYMMDD : Creation date of CERT C descriptor 

Version : Version of Agile+ Relief or PGRelief 

 

Example) C_20180401_pgr2018 

 

2.2 Setting of CERT guideline ID of inspection target 

 

CERT guideline ID to be inspected is defined in definition file. 

Please use definition file (default-certc.rul) stored in directory that stores CERT C 
Definition Files when you want to use CERT guideline ID that you belong to the Rule 
category. 

 

Please follow the following format to create the definition file: 

Put a semicolon at the beginning of the comment line. 

Write only one rule number or group name in a line. 

Use single-byte lower-case English letters for group name. 

Describe directory name that stores CERT C Definition Files at the head of the file. 

For more details of directory that stores CERT C Definition Files, please refer to [2.1 
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Setting of CERT C definition files]. 

The following error messages might be output when analyzing it without doing a 
correct statement. 

"PGRCDCHK_0416 An error XXX occurred in line 1 of definition file YYY." 

XXX: CERT guideline ID or group name 

YYY: Temporary file name (Agile+ Relief sets it to the optional) 

 

Example) Directory name that stores CERT C Definition Files is "C_20180401_pg
r2018". ARR30-C, ARR32-C of the CERT guideline ID, and a groups of Agile+ R
elief are inspected. 

 

 

 

 

 

The definition file is used for the CERT inspection. Please refer to [2.3.1 Create Project] 
(For the GUI use) and [2.4.3 Command Options] (For the Command line use) for 
details. 

 

2.3 CERT options in GUI 

 

2.3.1 Create Project 

 

When analyzing C/C++ source files in Agile+ Relief, management must be performed on 
the source files in the unit of a project. 

 

Select [New Project] from the [File] menu of the [Main Window]. 

 

;Rule=C_20180401_pgr2018 

ARR30-C 

ARR32-C 

group-a 
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The dialogue box "Project Wizard 1/3" will be displayed.  

 

 

 

Please enter "sample" in the Project Name.  

 

Please enter single-byte alphanumeric characters. Multi byte characters in the Project 

Name is not allowed.  
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Enter the directory to which you wish to save the projects in the Project Directory. Please 
enter "C:\demo\sample" in the sample.  

 

When a project name has been entered while a directory name is still required, the project 
name will automatically be appended to the end of the directory name.  

 

Select [Next]. 

 

"Project Wizard 2/3" dialogue box.  

 

 

 

The dialogue box is for Project Summary settings. 

In order to simplify illustration, the settings made here will be displayed in the Main 
Window to facilitate convenient reference for future projects.  

 

Note: Symbols including multi byte characters or spaces, and other such symbols are 
allowed in the Project Summary. (Ellipses are available)    

 

"Sample Project" is set for the illustration example.  

 

Select [Next].  

 

"Project Wizard 3/3" is displayed.  

 



 

7 

 

 

Add source files to this project in this dialogue box.  

 

"File" is set in File Selection.  

[C/C++ Source] is selected in File Category.  

Index is displayed on the left side of the dialogue box. 

 

Select "sample_cert" under the Agile+ Relief C/C++ installation directory .  

 

◆ Regarding classic installation, when Agile+ Relief C/C++ installation is complete, there 
will be installation samples in the sub-directory of "sample", "sample_new", 
"sample_misra", "sample_sec" and "sample_cert" created under the Agile+ Relief 
C/C++ installation directory .  

 

The source files used in the sample are displayed on the right side of the dialogue box.  

 

Drag the source files displayed in the list, and select all sample files.  

 

The settings of "Project Wizard 3/3" are as above.  

 

Select [Finish].  

 

A Project has been successfully completed.  
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The settings for analysis are as follows (option settings):   

 

The "Project Preference" dialogue box will be displayed: 

 

 

 

Select "Message Settings" option of "Project Preference" dialogue. 

 

 

 

When "Default value" is selected, inspection point Definition File (default-certc.rul) 
included in the directory that stores CERT C Definition Files. 

Select "All indications" when you inspect all rules. 
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Select "Customized indication" when you want to inspect only a specific CERT guideline 
ID. Besides, set the definition file" that describes the CERT guideline ID that you want to 
inspect. 

 

Select the "Coding Guidelines" option and then do the check of [Enable checking for 
Coding Guideline violations].  

 

 

 

[Coding Guideline] For Rule Settings:  

 

[MISRA-C V1] checks in accordance with MISRA-C:1998.  

[MISRA-C V2] checks in accordance with MISRA-C:2004. 

[MISRA-C V3] checks in accordance with MISRA-C:2012 and MISRA-C:2012 
Amendment 1. 

[MISRA-C++ V1] checks in accordance with MISRA-C++:2008. 

[IPA/SEC-C V1] checks in accordance with IPA/SEC-C V1.  

[IPA/SEC-C V2] checks in accordance with IPA/SEC-C V2. 

[IPA/SEC-C V3] checks in accordance with IPA/SEC-C V3 

[IPA/SEC-C++ V1] checks in accordance with IPA/SEC-C++ V1.  

[IPA/SEC-C++ V2] checks in accordance with IPA/SEC-C++ V2.  

[CERT C] checks in accordance with CERT C. 

 

 

 

- [MISRA-C V1], [MISRA-C V2] and [MISRA-C++ V1] cannot be selected when no license for MISRA 
option reserved. 
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- [MISRA-C V3] checks Coding Guideline violations by the rule added by MISRA-C:2012 Amendment 
1 in addition to MISRA-C:2012. Please refer to "3.3 MISRA-C V3" in "MISRA Option Manual", when 
you want to check Coding Guideline violations by the rule of MISRA-C:2012. 

- If you don't have CERT C option license, you can't select [CERT C]. 

 

Select [CERT C] here. 

 

Directory name that stores CERT C Definition Files is displayed in the list box of CERT C. 

 

"( Agile+ Relief C/C++ installation directory)\Analyze\EPOM\CertInfo\(Directory that stores 
CERT C Definition Files)" 

 

Select [C_20180401_pgr2018] here. 

 

[Content to Confirm] allows you to select and confirm the contents against Rules.  

 

[Coding Guideline violations only] is applied to selected Rules Violation Checks only.  

[ALL (Coding Guideline violations included)] is also applied to issues indicated in the 
viewpoints of Agile+ Relief besides selected Rules Violation Checks.  

 

In order to increase program quality and precision, the confirmation of issues indicated 
both by Coding Guideline and the viewpoints of Agile+ Relief is recommended.  

 

Select [ALL (Coding Guideline violations included)] here.  

 

Select [OK]. 

 

2.3.2 Execute analysis 

 

When the "Perform analyzing right now" query is displayed, please select [Yes].  

 

 

 

If you choose [No], please select [Analyze All] from the [Analyze] menu.  

 

When the analysis is in progress, the current state of and results pertaining to the analysis 
will be displayed in the log viewer. 
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No error occurred in the sample analysis. If an error occurred in actual practice and the 
desired analysis cannot be performed, please review the Compiler Type, Include Directory 
or Macro, and other such settings.  

 

2.3.3 Confirm result of the CERT inspection. 

 

Checking for CERT Violation. 

 

Select sample.c in the "Main Window", and then select [Coding Guideline Violations 
Viewer] from the [Tools] menu.  
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The "Coding Guideline Violations Viewer" window will be displayed: 

 

 

 

Brief Illustration on how to use the "Coding Guideline Violations Viewer":  
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In the [List of Files] window, files that have violated CERT are displayed. 

In the [List of Rules] window, the formal number of the CERT guideline ID that has been 
violated is displayed.  

In the [List of Messages] window, the contents and indicated row are displayed.  

 

When "List by File" on the toolbar is changed to "List by Rule", the [List of Files] window 
will be switched to the [List of Rules] window.  

 

When a rule number in [List of Rules] is selected, information corresponding to the 
message will be displayed in the [Message] window.  

 

Please confirm the indicated locations in order and modify the source files.  

 

Some CERT guideline ID’s may sometimes refer to the same message.  

For example, the message ID: pgr6000 indicated in line 35 of the sample corresponds to 
CERT guideline ID of CON31-C and POS48-C.  

 

Please select the rules in the [List of Rules] window, and then make modifications 
accordingly; select all rules and make all modifications to each number of the source 
codes to ensure efficiency and avoid repetition.  

 

As the source codes of the sample, select the [Line] title to display line numbers in 
ascending order and modify them from top to bottom.  

 

[List of Files]window [List of Rules]window 

[List of Messages]window 

[Message]window 



 

14 

Select pgr6000 in line 35 and then right click to select [Open Pgr Viewer].  

 

 

 

Pgr Viewer will startup. 

 

 

Confirm the places where modifications are required, and make the according 
modifications by using the existing editor.  
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When message information is difficult to understand, please right click to select [Message 
Details].  

 

 

 

The [Help] window will be opened. Please modify with regard to the relevant contents.  
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2.3.4 Experienced with Agile+ Relief C/C++ 

 

Project creation using the CERT option is similar to using normal project.  

Indeed, the only point that requires explanation regards appending the [Coding 
Guidelines] settings in [Project Preference].  

 



 

17 

 

 

In addition, one other point concerning the [Coding Guideline Violations Viewer] window is 
different, that is "Message ID List" in "Message Information" window is displayed as "Rule 
Number List". The others are similar in operation. 

 

 

 

2.4 CERT options in Command line 

 

2.4.1 Functions of Command 
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The pgrcert command is used to check the messages output in pgr5 command and output 
the messages for CERT Violation. In addition, the message contents output in pgr5 must 
be output in files with the CSV format. Moreover, it is necessary to be output by the 
environment for which the CERT option can be used. 

Please confirm the following before the Execution of the pgr5 commands.  

Specify "--cert" option and "-- csv" option for the pgr5 commands. 

 

2.4.2 Format of Command 

 

% pgrcert [-V] [-M] [--pgr] -TCERT Version [-Z definition file for rule checking]  

           Input File 

 

Note: [ ] means omittable.  

 

2.4.3 Command Options 

 

Options Explanation 

-V Displays pgrcert command version,level and 
release number. When this option is 
specified, other options are ignored.  

-M The Agile+ Relief indication ID corresponding 
to the CERT guideline ID is displayed. 

Specify -T option when you specify this 
option. Options other than -T cannot be used. 

--pgr Outputs pgr5 command messages  
simultaneously.  

-TCERT Version Specifies the directory name that stores 
CERT C Definition Files. It is always 
necessary. 

Do not put the white-space between -T and 
CERT Version. 

Windows version: 

"(Agile+ Relief C/C++ installation directory)\
Analyze\EPOM\CertInfo\(Directory that stor
es  
CERT C Definition Files)" 

 

Linux version: 

(Agile+ Relief C/C++ installation directory)/
Analyze/ 
EPOM/CertInfo/(Directory that stores  
CERT C Definition Files) " 
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For more details of the CERT C Definition
 Files, please refer to [2.1 Setting of  
CERT C definition files]. 

-Z definition file for rule checking  If you want to output only certain rules, 
specify them in the definition file. 

You may refer to section 2.2 [Setting of CERT 
guideline ID of inspection target] for the 
syntax of the definition file. 

If the option on the left is not specified, all 
rules will be output.  

Input Files  Saves file names of the pgr5 command 
messages in the CSV format.  

File will be saved in the following codes. 

Chinese OS 

 GB2312 code 

OS in other languages 

 Windows : SJIS code 

 Red Hat Enterprise Linux 5 or 6 

          : UTF-8 code 

 Others   : EUC code 

 

 

2.4.4 Return Value 

 

When the pgrcert command ends normally, it will return to 0. If an error has occurred, it 
will be returned to a value other than 0.  

 

2.4.5 Output Files 

 

Output Files will be output in the csv format. 

 

Output Result Samples:   

 

C:\sample.c",36,"PRE00-C","Recommendation","L3, Low, Unlikely, Medium, P4 
","pgr0667","unexecuted." 

 

Format Explanation: 

 

source file name   "C:\sample.c" 

line number   36 

rule number   "PRE00-C" 
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rule category   "Recommendation" 

rule group    "L3, Low, Unlikely, Medium, P4" 

message group   "b" 

message ID   "pgr0667" 

message information "unexecuted." 

 

2.4.6 Example for Use 

 

2.4.6.1 Confirmation of CERT guideline ID that can be checked 

 

Output the Agile+ Relief indication ID related to the CERT guideline ID by the pgrcert 
command. 

 

[Example]:   

pgrcert -M -TC_20180401_pgr2018 

        1          2 

 

1: Commands option that outputs Agile+ Relief indication ID corresponding to CERT  

guideline ID. 

2: Directory name that stores CERT C Definition Files 

 

 

2.4.6.2 Analyze with pgr5 command 

 

Use the pgr5 command to perform source file analysis for the purpose of obtaining a 
message to be checked by the pgrmisra command.  

 

[Example]: 

pgr5 --cert 

      1 

 -F "c:\PGRelief\Analyze\EPOM\CertInfo\C_20180401_pgr2018\CERT_C.idt" 

                     2 

 --csv sample.c > message.csv 

   3     4           5 

 

1: Command option to output special Agile+ Relief point for CERT option. 

2: Identifier file for CERT inspection. 

 [Saving Directory for Identifier Files] 

Windows version: 
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"(Agile+ Relief C/C++ installation directory)\Analyze\EPOM\CertInfo\ 
(Directory that stores CERT C Definition Files)" 

Linux version: 

"(Agile+ Relief C/C++ installation directory)/Analyze/EPOM/CertInfo/ 
(Directory that stores CERT C Definition Files)" 

 

[Identifier File Name] 

CERT_C.idt 

 

The Identifier File specified by "-F” option of the pgr5 commands should be the File 
stored in "Directory that stores CERT C Definition Files" specified by "-T" option" of 
the pgrcert commands. 

 

3: Outputs the message in CSV format. 

4: Analysis the source files of the objects. 

5: Saves the target file of message contents output in CSV format. 

 

For further details regarding the pgr5 command, please refer to the "Command Manual".  

 

 

2.4.6.3 CERT inspection by pgrcert commands 

 

Inspect the execution result of the pgr5 commands to output the violation of CERT. 

 

[Example]   

pgrcert -TC_20180401_pgr2018 -Z"c:\demo\Rule\CERT_C.txt" message.csv 

                 1                       2                   3 

 

1: Directory name that stores CERT C Definition Files. 

2: Definition file of CERT guideline ID that you want to apply. 

3: Saves the files of message contents of pgr5 command in CSV format. 

 

 

[Notes]: 

Please note the codes of input files for pgrcert(3 in the above sample).  

There is the pgr5 command to execute necessity after specifying "--cert" option and 
"--csv" option.. 

 

In Chinese OS, the input file for the pgrmisra command for both Windows and Linux 
needs to be output in GB2312 code.  

In other language OS, the input file for the pgrmisra command needs to be output in SJIS 
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code for Windows and UTF-8 code for Red Hat Enterprise Linux 5 or 6, and the rest in 
EUC code. 

When the "--output_code" option is used with the pgr5 command, specify the option to 
enable output with the above code. For further details regarding the pgr5 command, 
please refer to the "Command Manual". 

 

 

2.5 Error Messages  

 

PGRCERT_0001  Input file is not specified.  

Input file is not specified. Please recheck the command format and then re-execute. 

 

PGRCERT_0002  The option cannot be specified when the input file is specified.  

Command Format Error. Please confirm the command format and then re-execute.  

 

PGRCERT_0003  Multi input files cannot be specified.  

Multi input files are specified. Please confirm the command format and then re-execute.  

 

PGRCERT_0004  Option error.  

Option error. Please specify the correct option.  

 

PGRCERT_0005  -T option is not specified.  

-T option is not specified. Please be sure to specify one of options. 

 

PGRCERT_0006  -T option cannot be specified at the same time.  

-T option cannot be used for two or more simultaneouses. Please specify only one. 

 

PGRCERT_0040  Parameter of option -Z is not specified. 

In option -Z, the definition file for rule checking is not specified. You may execute it 
again after confirming the command's format. 
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3 Viewpoint of CERT inspection 

 

This chapter explains the violation of CERT that Agile+ Relief indicate. 

 

3.1 CERT guideline ID that Agile+ Relief indicate 

 

When it meets the following requirement, and the CERT C Definition Files are made, 
Agile+ Relief indicate the CERT guideline ID. 

Risk Assessment of the CERT guide line ID is set in SEI CERT C Coding Standard. 
(https://wiki.sei.cmu.edu/confluence/display/c/SEI+CERT+C+Coding+Standard) 

The Agile+ Relief indication ID related to the CERT guideline ID exists. 

 

For more details of CERT guideline ID, please refer to [2.4.6.1 Confirmation of CERT 
guideline ID that can be checked]. 

 

For more details of CERT inspection, please refer to [2.3 CERT options in GUI] or [2.4 
CERT options in Command line]. 

 

3.2 Agile+ Relief Indication Message and action 

 

Please refer to SEI CERT C Coding Standard 
 (https://wiki.sei.cmu.edu/confluence/display/c/SEI+CERT+C+Coding+Standard)  
for the content of the CERT guideline ID.  

 

Please deal referring to Agile+ Relief indication ID and indication message corresponding 
to it when you deal with the detected CERT guideline ID. 

 


	Title Page
	Foreword
	Contents
	1 Before using the Agile+ Relief CERT option
	1.1 What is the CERT option
	1.2 Shipped-conditions of CERT option
	1.3 License management
	1.4 Limitation
	1.4.1 pg5 Command
	1.4.2 Cooperation with Agile+ Relief
	1.4.3 Linkage Tools (Diagnosis report, CI tool Collaboration Jenkins Plugin)


	2 Let's use CERT option
	2.1 Setting of CERT C definition files
	2.2 Setting of CERT guideline ID of inspection target
	2.3 CERT options in GUI
	2.3.1 Create Project
	2.3.2 Execute analysis
	2.3.3 Confirm result of the CERT inspection.
	2.3.4 Experienced with Agile+ Relief C/C++

	2.4 CERT options in Command line
	2.4.1 Functions of Command
	2.4.2 Format of Command
	2.4.3 Command Options
	2.4.4 Return Value
	2.4.5 Output Files
	2.4.6 Example for Use
	2.4.6.1 Confirmation of CERT guideline ID that can be checked
	2.4.6.2 Analyze with pgr5 command
	2.4.6.3 CERT inspection by pgrcert commands

	2.5 Error Messages

	3 Viewpoint of CERT inspection
	3.1 CERT guideline ID that Agile+ Relief indicate
	3.2 Agile+ Relief Indication Message and action


